Session 1: Exercise

Create a new ASP.NET Web Application project in your sample files folder called: Exercisel
Add a new Web Form item to the project called: mypage.aspx

Add a Calendar control to the mypage.aspx page.

Use QuickTasks to Auto Format the Calendar control to the Colorful 1 scheme.

Change the ID property of the Calendar control to: CalendarColorful

Add a new folder to the project called: Images
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Add a HTML Image control to the page using the HTML category of the ToolBox.

©

Set the Src property of the new Image control to: Images/pattern.jpg

-
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Delete the About.aspx page.
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Set mypage.aspx to be the project’s start page.

-
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Start the project in debug mode.

-
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Save your work.
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Add the pattern.jpg file from the Images folder in your sample files folder to your new Images folder.

If you need help
slide the page to
the left
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Session 1: Exercise Answers

These are the four questions that students find the most difficult to answer:

Q7

1. Right-click on the Images
folder in the Solution
Explorer.

2. Click: Add->
Existing Item... from the
shortcut menu.

3. Browse to the
C:\Practice\ASP.NET\Images
folder.

4. Click on pattern.jpg and
then click Add.

This was covered in: Lesson
1-7: Manage a project with the
Solution Explorer.

Q6

1. Right-click on
Exercisel in the
Solution Explorer.

2. Click Add~>
New Folder from the
shortcut menu.

3. Type the name:
Images

This was covered in:
Lesson 1-7: Manage a
project with the Solution
Explorer.

Qs

1. Click on the calendar
in Design view.

2. Scroll down in the
Properties window until

you see the ID property.

3. Click in the box that
currently says Calendarl
and change the text to:
CalendarColorful

This was covered in:
Lesson 1-12: Change
properties in Design view.

Q3

1. Double-click on
mypage.aspx in the
Solution Explorer.

2. Click on the Design
button at the bottom
of the main panel.

3. Drag a Calendar
control from the
ToolBox to the page.

This was covered in:
Lesson 1-14: Add
controls to a page with
the Toolbox.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:

1 Refer to: Lesson 1-5: Create an ASP.NET Web Application project.
2 Refer to: Lesson 1-7: Manage a project with the Solution Explorer.
4 Refer to: Lesson 1-15: Use the QuickTasks menu.

8 Refer to: Lesson 1-14: Add controls to a page with the Toolbox.

9 Refer to: Lesson 1-12: Change properties in Design view.

10 Refer to: Lesson 1-7: Manage a project with the Solution Explorer.

11 Refer to: Lesson 1-8: Run a project.

12
13

Refer to: Lesson 1-8: Run a project.

Refer to: Lesson 1-9: View .aspx pages in Source and Design views.
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Session 2: Exercise
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If you need help
‘ HTMLTest - start | ‘ HTMLTest - end | stide the page o

Open exercise.aspx within the HTMLTest sample project in Source view.

Set the page title in the head section to: Session 2 Exercise

Add a link to the CSS file called layout.css. It can be found in the styles folder.
Add a pair of div tags to the page (between the form tags).

Type the text Site Name between the div tags.

Set the class property of the div tag to the CSS class: header

Switch to Design view and add an HTML table to bottom of the page.

Remaining in Design view, merge the bottom two cells of the HTML table.

In the first cell of the HTML table, type the text: Site

Switch to Source view and make the Site text bold using HTML.

Switch to Design view and type the text: Learn ASP 4 web site into the top-right table cell.
Make the text you have just typed a hyperlink to: http://www.ASPNETCentral.com.

Add an HTML image element to the bottom row of the table and reference it to the pattern.jpg image
in the images folder.

Using the CSS Properties window, set the color CSS property of the Site Name text to: White
Add a link to the JavaScript file exercise.js. It can be found in the scripts folder.

Add JavaScript code to exercise.js to display a pop-up message.

| %

(<
Learn ASP4 Web Site
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Session 2: Exercise Answers

These are the four questions that students find the most difficult to answer:

Q14

1. Switch to Design view.

2. Click on the header div so
it is highlighted.

<DIV> should appear as the
selected item in the
Properties window.

3. Click View—>
CSS Properties.

4. Open the drop-down list
next to color in the CSS
Properties window and click
the white box.

color M Black (&)
J Standard Colors:

This was covered in: Lesson
2-9: Use the CSS Properties
window.

Q8

1. Switch to Design
view.

2. Click and drag from
the bottom-left cell of
the table to the bottom
right, so they are both
highlighted.

3. Click
Table>Modify->
Merge Cells.

This was covered in:
Lesson 2-5: Create an
HTML table.

Q7

1. Switch to Design
view.

2. Click below the header
div.

3. Click Table=>
Insert Table.

4. Click OK on the
dialog that appears.

This was covered in:
Lesson 2-5: Create an
HTML table.

Q6

1. Switch to Source
view.

2. Modify the div tag
to:

<div class="header">
Site Name
</div>

This was covered in:
Lesson 2-10: Use the
div and span tags.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:

1

2 Refer to:
3 Refer to:
4 Refer to:
5 Refer to:
9 Refer to:
10 Refer to:
11 Refer to:
12 Refer to:
13 Refer to:
15 Refer to:
16 Refer to:

Lesson 2-10: Use the div and span tags.
Lesson 2-10: Use the div and span tags.

Lesson 2-5: Create an HTML table.

Lesson 2-5: Create an HTML table.

Lesson 2-11: Work with JavaScript.

Refer to: Lesson 1-7: Manage a project with the Solution Explorer.
Lesson 2-4: Use the title, meta, link and script tags.

Lesson 2-4: Use the title, meta, link and script tags.

Lesson 2-1: Understand HTML bold, italic and heading tags.

Lesson 2-7: Display images and links on a page.
Lesson 2-7: Display images and links on a page.

Lesson 2-4: Use the title, meta, link and script tags.
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Session 3: Exercise

1 Open the CSharpTest sample project and open exercise.aspx.
Disable ViewState on the TextBoxText control by setting its EnableViewState property to: False

Add a Click event handler to the ButtonChangeText control.

H WON

Add code to the new Click event handler to set the Text property of the TextBoxText control
to: The Smart Method

Add a Click event handler to the ButtonSendData control.

Add code to the ButtonSendData control’s Click event to move to passdata2.aspx using Server. Transfer.
Set a breakpoint in the Click event of ButtonSendData.

Run exercise.aspx in Debug mode and type some text into the text box.

Click Send Data and then use the Watch window to get the value of TextBoxText.Text.

= ©O© 00 N O O

0 Stop debugging and add code to the ButtonSendData control’s Click event handler to store the Text of
the TextBoxText control in Session under the key of Text.

11 Change the ButtonSendData control’s Click event handler to redirect the user to passdata4.aspx using
Response.Redirect instead of Server. Transfer.

If you need help
CSharpTest - start | CSharpTest - end | :}1:;1;}(19 page to
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Session 3: Exercise Answers

These are the four questions that students find the most difficult to answer:

Q9 Q7 Q6 Q3

1. Run exercise.aspx in 1. Open the code- 1. Open the code-behind 1. Open exercise.aspx
Debug mode by clicking: | behind file of file of exercise.aspx. in Design view.

Debug>Start Debugging. | exercise.aspx. 2. Add the following code | 2. Select the

2. Click on the Send Data | 2. Right-click on the to the ButtonSendData_Click | ButtonChangeText

button. Page.Server. Transfer line | event handler: control by clicking
in the on it.
Your code will b d |7 Page.Server.
our code will be pause ButtonSendData_Click age.Server

Transfer("passdata2.aspx"); | 3. Click on the Events
button in the
Properties window.

3. Return to the code- event handler.

behind file of exercise.aspx ) ) This was covered in: Lesson
3. Click: Breakpoint—>

if you aren’t i 3-10: Move between pages.
. Insert Breakpoint from #
automatically sent there.
the shortcut menu.
4. Click on the Watch Thi din: 4. Double-click in the
button at the bottom of 18 was covered im: empty box next to
Lesson 3-3: Use )
the screen. . Click.
Breakpoints.
5. Click in an empty box This was covered in:
in the Watch window and Lesson 3-2: Add event
type: handlers to Controls.

TextBoxText. Text
6. Press <Enter>.

This was covered in:
Lesson 3-3: Use
Breakpoints.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:
Refer to: Lesson 1-7: Manage a project with the Solution Explorer.

Refer to: Lesson 3-9: Work with ViewState.

Refer to: Lesson 3-1: Change properties with C#.

Refer to: Lesson 3-2: Add event handlers to Controls.

Refer to: Lesson 1-8: Run a project in debug mode.

Refer to: Lesson 3-11: Send data between pages.

- = 00 01 AN -
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Refer to: Lesson 3-10: Move between pages.
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Session 4: Exercise

Open the ShiningStone sample project and open buy.aspx in Design view.
Set the maximum length of each of the address text box controls to 50.
Make each of the address text boxes 50 columns wide.

Add a CheckBox control in the space before the Submit Order button.

Set the CheckBox ID property to: CheckBoxAcceptTerms

©W 00 N O O A ODN -

box.

-
o

Make the font of the Submit Order button bold.

4 ;.

Set the Text property of the CheckBox control to: I accept the terms and conditions

Add a RequiredFieldValidator control next to the Address 2 text box and set it up appropriately.

Add a RequiredFieldValidator next to the Post Code text box and set it up appropriately.

Make the background color of the Post Code text box match the background color of the Address 1 text

Home News Store Contact

You are buying:

Please fill in the form below with your address details and phone number.
A sales representative will contact you to arrange payment.

Address 1 [ *
Address 2 | *
Address 3

Address 4

Country Afghanistan [+]

Post Code [ ™

Phone Number [abc *

[T accept the terms and conditions

Submit Order

Address 1 Required
Address 2 Required
Post Code Required
Invalid Phone Number

‘ ShiningStone - start | ‘ ShiningStone - end |

If you need help
slide the page to
the left

© 2014 The Smart Method Ltd
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Session 4: Exercise Answers

These are the four questions that students find the most difficult to answer:

Q9

1. Open buy.aspx in
Design view.

2. Click one of the
pink text boxes.

3. Look at the
BackColor property.

You will see it is
#FFCCCC.

4. Click the Post Code
text box.

5. Set the BackColor
property to:
#FFCCCC

This was covered in:
Lesson 1-12: Change
properties in Design
view.

Q7

1. Open buy.aspx in Design view.

2. Drag a RequiredFieldValidator
from the Validation category of the
Toolbox to the space after
TextBoxAddress2.

3. Select the RequiredFieldValidator.

4. Set the ID property to:
RequiredFieldValidatorAddress2

5. Set the Text property to: *

6. Set the ErrorMessage property
to: Address 2 Required

7. Set the ControlToValidate
property to: TextBoxAddress2

This was covered in: Lesson 4-8:
Use the RequiredFieldValidator
control.

Q6

1. Open buy.aspx in
Design view.

2. Select CheckBox1 and
set its ID property to:
CheckBoxAcceptTerms
This was covered in:

Lesson 4-1: Name controls
correctly.

Q2

1. Open buy.aspx
in Design view.

2. Select each of
the address text
box controls by
clicking on them.

3. Set the
MaxLength
property of each
text box control
to: 50

This was covered
in: Lesson 4-4: Use
text boxes.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:

= 00 O ~h W =

Refer to: Lesson 4-4: Use text boxes.
Refer to: Lesson 4-5: Use check boxes.

Refer to: Lesson 4-5: Use check boxes.

0 Refer to: Lesson 4-10: Use common properties.

Refer to: Lesson 1-7: Manage a project with the Solution Explorer.

Refer to: Lesson 4-8: Use the RequiredFieldValidator control.

© 2014 The Smart Method Ltd
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Session 5: Exercise

1 Open the My Project sample project and open calculator.aspx in Design view.
Add a new Button control to the page called: ButtonCalculate2

Add a Click event handler to the ButtonCalculate2 control.

H WON

Create a string variable called PIString in the ButtonCalculate2_Click event handler with a value of:
"3.14159265"

5 Create a double variable called PIDouble in the same event handler and set its value to the value of
the PIString variable by using the Convert method.

6 Create an int variable in the same event handler called CircleRadius with a value of: 19

7 Create a double variable in the same event handler called CircleCircumference with a value of:
PIDouble * CircleRadius

8 Use the Pow function from the Math library to raise the CircleCircumference variable to the power of 2.
9 Convert the CircleCircumference variable to a string using the ToString method. Call the string:
OutputCircumference

10  Create a DateTime variable called TodaysDate containing today’s date.

If you need help
My Project - start My Project - end | :}Ejfe?;e page to
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Session 5: Exercise Answers

These are the four questions that students find the most difficult to answer:

Q9 Q8 Qs Q4

Use the following line of | Use the following line | Use the following line of Use the following
code: of code: code: line of code:
string CircleCircumference = | double PIDouble = string PIString =
OutputCircumference = | Math.Pow Convert.ToDouble(PIString); | "3.14159265";
Clrcle'Clrcumference (CircleCircumference, This was covered in: Lesson This was covered
-ToString(); 2; 5-8: Convert variables using in: Lesson 5-3: Use
This was covered in: This was covered in: Convert and Parse. string variable
Lesson 5-8: Convert Lesson 5-11: Use the properties and
variables using Convert and | Math library for methods.

Parse. advanced mathematics.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:
Refer to: Lesson 1-7: Manage a project with the Solution Explorer.

Refer to: Lesson 1-14: Add controls to a page with the Toolbox.

Refer to: Lesson 3-2: Add event handlers to Controls.

Refer to: Lesson 5-4: Use integer variables.

Refer to: Lesson 5-10: Perform basic mathematical operations.

= N O W N -

0 Refer to: Lesson 5-7: Use DateTime variables.

© 2014 The Smart Method Ltd 179



Session 6: Exercise

H WON

10
11
12
13

14
15

16
17

If you need help
My Project - start | My Project - end | :}ljgfe;?e page to

Open the My Project sample project and add a new class called: Circle.cs
Add a public double property to the Circle class called: CircleCircumference
Add a public method to the Circle class called: CalculateDiameter

Make the CalculateDiameter method return a double value.

(Don’t worry about the indicated error, this will be overcome in question 6).
Make the CalculateDiameter method ask for a double argument called: Radius

Add code to the CalculateDiameter method to multiply the Radius argument by 2 and return the
result.

Add a constructor to the Circle class.

Make the constructor require a double value as an argument called: Circumference

Make the constructor set the CircleCircumference property to the value of the Circumference argument.
Make the CalculateDiameter method static.

Add a new Web Form to the project called: circlecalculator.aspx

Open the code-behind file of circlecalculator.aspx.

Add code to the Page_Load event handler to create an instance of the Circle class named MyCircle
using a Circumference argument of: 50

Add code on the next line to create a new double variable called: MyCircleDiameter

Add code on the next line to call the static CalculateDiameter method of the Circle class with a Radius
argument of 7.95, storing the resulting value in the MyCircleDiameter variable.

(Remember that CalculateDiameter is a static method and is called in a different way to normal
methods).

Add code to output the value of MyCircleDiameter using Response.Write.

View circlecalculator.aspx in your browser.

. = i
& http://localhost:51066/ci... fi ~ B v [ de v Pagev Safetyv Took~ @~
159
Done €& Local intranet | Protected Mode: Off g~ | HI00% ~
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Session 6: Exercise Answers

These are the four questions that students find the most difficult to answer:

Change the line that starts | Use the following code: | Use the following line of | Use the following

the CalculateDiameter . code: code to add the
public Circle() .

method to: { return Radius * 2; public method:

public stati.c double } This was covered in: public void‘

CalculateDleTmeter This was covered in: Lesson 6-7: Create methods CalculateDiameter()

(double Radius) Lesson 6-11: Create class | that return a value. i

This was covered in: Lesson
6-9: Create a static method.

constructors.

This was covered in:
Lesson 6-5: Create and

use methods.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:

1 Refer to: Lesson 6-1: Create a class.

2 Refer to: Lesson 6-1: Create a class.

4 Refer to: Lesson 6-7: Create methods that return a value.

5 Refer to: Lesson 6-6: Create methods with arguments.

8 Refer to: Lesson 6-11: Create class constructors.

9 Refer to: Lesson 6-11: Create class constructors.

11 Refer to: Lesson 1-7: Manage a project with the Solution Explorer.
12 Refer to: Lesson 1-7: Manage a project with the Solution Explorer.
13 Refer to: Lesson 6-11: Create class constructors.

14 Refer to: Lesson 5-5: Use floating point variables.

15 Refer to: Lesson 6-9: Create a static method.

16 Refer to: Lesson 3-7: Understand Request and Response.

17 Refer to: Lesson 1-8: Run a project in debug mode.

© 2014 The Smart Method Ltd
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Session 7: Exercise

10

11

12

Spark - start | ’/3;;;(1 | slide the page to
the left

Open the Spark sample project and open viewtransactions.aspx in Design view.
Add a SelectedIndexChanged event handler to the DropDownListSelectedPeriod control.

Add an if statement to the event handler that checks if the value of the DropDownListSelectPeriod
control’s SelectedValue property is equal to: "2010"

If the value of the property is "2010", make your if statement change the Panel2010.Visible property to
true and the Panel2011.Visible property to false.

Use else if to check if the value of the property is "2011". If it is, set the Panel2011.Visible property to
true and the Panel2010.Visible property to false.

Open viewtransactions.aspx in your browser and test your code.

Spark Accounts

Home New Invoice View Invoices Reports
Period: | 2010 [+]
2010 Invoices
Invoice Number Customer Date

4981 Lehmanns Marktstand 01/01/2010
9557 Magazzini Alimentari Riuniti 01/01/2010
1579 Lehmanns Marktstand 02/01/2010
8847 QUICK-Stop 02/01/2010

Close your browser and open the code-behind file of newtransaction.aspx.

Add an if statement to the start of the ButtonSubmit_Click event handler to check if the value of the
DropDownListCustomer control’s SelectedValue property is "6", "9" or "11". If so, set the Text property
of the LabelError control to:

That customer is currently out of use

Add an else statement to the ButtonSubmit_Click event handler which will run if the value of the
property is not "6", "9" or "11".

Add try and catch statements to the ButtonSubmit_Click event handler and place any error messages
in the Text property of the LabelError control.

Add a comment to the CalculateVAT method to explain what it does. (VAT or Value Added Tax is a
sales tax levied in Europe).

Add a summary to the CalculateVAT method and populate it with useful descriptions.

If you need help
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Session 7: Exercise Answers

These are the four questions that students find the most difficult to answer:

Q10

Add the code: After the end of

try your last if

{ statement, add the
code:

...at the very beginning

of the event handler. {else

At the very end of the }
event handler, add:

} in: Lesson 7-2: Use
catch (Exception Ex) else and else if.
{
LabelError.Text =
Ex.Message;
}

This was covered in:
Lesson 7-6: Use try and
catch to handle errors.

Q9

This was covered

Q8

Use the following lines of
code:

string CustomerID =

DropDownlListCustomer

.SelectedValue;

if (CustomerID =="6"

I | CustomerID =="9"

[l CustomerID =="11")

{
LabelError.Text =
"That customer is
currently out of use.";

}

This was covered in:
Lesson 7-3: Use basic
logical operators.

Q4

Use the following lines of
code:
if
(DropDownlListSelectPeriod
.SelectedValue == "2010")
{
Panel2010.Visible = true;
Panel2011.Visible = false;
}

This was covered in:
Lesson 7-1: Use the if
statement.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:

Refer to:
Refer to:
Refer to:
Refer to:
Refer to:
Refer to:

Refer to:

= =N O W DN -
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Refer to:

Lesson 1-7: Manage a project with the Solution Explorer.

Lesson 3-2: Add event handlers to Controls.

Lesson 7-1: Use the if statement.

Lesson 7-2: Use else and else if.

Lesson 1-8: Run a project in debug mode.

Lesson 1-7: Manage a project with the Solution Explorer.

Lesson 7-7: Use comments.

Lesson 7-8: Use summaries.

© 2014 The Smart Method Ltd
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Session 8: Exercise

1 Open the My Project sample project and create a new class called: MyData.cs

2 Add a new public method called GetNumbers, which returns an array of int variables.

(You'll see an error at this stage as you have not yet created code that returns a value).

3 Create an array of int variables called Numbers in the GetNumbers method containing the numbers:
1,1, 3, 5, 8 and make the method return the array.

(The previously flagged error should disappear as soon as you specify the return value).
4 Add a new public method called GetNames, which returns a List of string variables.
(You'll see an error at this stage as you have not yet created code that returns a value).

5 Create a List of string variables called Names in the GetNames method containing the names: "Mike",

"non

"Simon", "Emily" and make the method return it.

The previously flageed error should disappear as soon as you specify the return value).
P y tlagg pPp y pecity
6 Add a new public method called ProcessNames, which doesn’t return a value.

7 Create a List of string variables called NamesToProcess in the ProcessNames method and populate it
with the List collection returned by the GefNames() method.

8 Use a for loop to loop through the list of names and make each one upper case using the ToUpper
method of the string variable type.

9 Add a new public method called AppendNames which returns a string value.

(You'll see an error at this stage as you have not yet created code that returns a value).

10 In the new method, add a foreach loop which loops through the names returned by the GetNames
method and appends them all to a single string variable. Make the method return the string.

11 Add a new page called test.aspx and use the Page_Load event handler to call the AppendNames
method of the MyData class and output the return value to the top of the web page.

X

& http:/Nlocalhost61066/t... ’?i" B v = o v Pagev Safety~

MikeSimonEmily

€L Local intranet | Protected Mode: Off fa ~ SHI00% -

If you need help
My Project - start | My Project - end | :}l:df ;}tle page to
e 1e
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Session 8: Exercise Answers

These are the four questions that students find the most difficult to answer:

Q10

Use the following code:

public string
AppendNames()
{
string
AppendedNames ="";
foreach (string Name
in GetNames())
{
AppendedNames =
AppendedNames +
Name;
}
return
AppendedNames;
}

This was covered in:
Lesson 8-3: Iterate through
a collection using foreach.

Q8

Use the following code:

public void
ProcessNames()
{
List<string>
NamesToProcess =
GetNames();
for (int Counter =0;
Counter <
NamesToProcess.Count;
Counter++)
{
NamesToProcess
[Counter] =
NamesToProcess
[Counter].ToUpper();
}
}

This was covered in: Lesson
8-4: Iterate through a
collection using a for loop.

Q5

Use the following code:

public List<string>

GetNames()

{
List<string> Names =
new List<string>();
Names.Add("Mike");
Names.Add("Simon");
Names.Add("Emily");
return Names;

}

It is also possible to do
this using less code.

This was covered in:
Lesson 8-2: Create a
collection.

Q3

Use the following
code:

public int[]

GetNumbers()

{
int[] Numbers =
new int[5];
Numbers[0] =1;
Numbers[1]=1;
Numbers|[2] = 3;
Numbers[3] = 5;
Numbers[4] = 8;
return Numbers;

}

It is also possible to
do this using less
code.

Both this and the
alternative
technique were
covered in: Lesson
8-1: Create an array.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:

- O N O AN -

Refer to: Lesson 6-1: Create a class.

Refer to: Lesson 6-5: Create and use methods.

Refer to: Lesson 8-2: Create a collection.

Refer to: Lesson 6-7: Create methods that return a value.

of a class, Lesson 3-7: Understand Request and Response.

Refer to: Lesson 6-7: Create methods that return a value, Lesson 8-1: Create an array.

Refer to: Lesson 6-7: Create methods that return a value, Lesson 8-2: Create a collection.

1 Refer to: Lesson 1-7: Manage a project with the Solution Explorer, Lesson 6-2: Create an instance

© 2014 The Smart Method Ltd

245




Session 9: Exercise

1 Create a new ASP.NET Web Application in your sample files folder, named: Session9

2 Start the project in Debug mode, view its pages and then close your web browser.

(This is necessary because the project must be built before the ASP.NET Configuration utility will
work properly. Starting debugging causes the project to be built).

Open the ASP.NET Configuration utility for your new project.
Enable roles for the application.

Add a new role called: Moderator

Add a new folder to the project called: Moderate

Add a new aspx page to the Moderate folder called: default.aspx

Add a Calendar control to your new page.

© 00 N O G b~ W

Use the ASP.NET Configuration utility to add access rules to allow only users with the Moderator role
to access the Moderate folder.

10 Create a new user account and assign it to the Moderator role.
11 Attempt to view the new default.aspx page in the Moderate folder in your browser.

12 Log in when prompted using the user you created in step 10.

If all of the above questions were completed correctly you will now see the new default.aspx file in
the Moderate folder.

1; Favorites & http://localhost:62071/moderate/default.aspx

< May 2011 >
Mon Tue Wed Thu Fri Sat Sun
25 26 27 28 19 30 1
2 3 4 5 6 1 8
2 1 11 B2 B 1 IS5
l6 17 18 19 20 21 22
23 24 25 26 27 28 29
6 31 1 2 3 4 3

If you need help
Session9 - end slide the page to
the left
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Session 9: Exercise Answers

These are the four questions that students find the most difficult to answer:

Q10

1. Open the ASP.NET
Configuration utility (if it
isn’t open already).

2. Click the Security tab.

3. Click Create user.

4. Complete the form.

5. Check the Moderator box.
6. Click Create User.

This was covered in:
Lesson 9-1: Use .NET’s built-
in security features.

Q9

1. Open the ASP.NET
Configuration utility.

2. Click the Security tab.

3. Click Manage Access
Rules.

4. Click the Moderate
folder on the left.

5. Click Add new access
rule.

6. Click Allow.
7. Click OK.

8. Click Add new access
rule.

9. Click Anonymous
Users.

10. Click Deny.
11. Click OK.

This was covered in:
Lesson 9-8: Add folder-
level security.

Q5

1. Open the ASP.NET
Configuration utility.

2. Click the Security tab.

3. Click Create or Manage
roles.

4. Type Moderator into
the New role name text
box.

5. Click Add Role.

This was covered in:
Lesson 9-9: Set up roles.

Q3

Click Project->
ASP.NET
Configuration.

Alternatively, click
the icon in the
Solution Explorer:

i

This was covered in:
Lesson 9-2: Manage a
site with ASP.NET
Configuration.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:

= = 00 N O AN -
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Refer to: Lesson 9-9: Set up roles.

Refer to: Lesson 1-5: Create an ASP.NET Web Application project.

Refer to: Lesson 1-8: Run a project in debug mode.

Refer to: Lesson 1-7: Manage a project with the Solution Explorer.
Refer to: Lesson 1-7: Manage a project with the Solution Explorer.
Refer to: Lesson 1-14: Add controls to a page with the Toolbox.
Refer to: Lesson 9-1: Use .NET’s built-in security features.

Refer to: Lesson 9-1: Use .NET’s built-in security features.
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Session 10: Exercise

1 Open the Session10 project from your sample files folder.

2 Add LINQ to SQL Classes to the project. Call the file: Session10.dbml

3 Add the Customer table from the Spark database to the LINQ to SQL Classes.

4 Add the SpGetLastInvoiceNumber stored procedure from the Spark database to the LINQ fo SQL
Classes.

5 Open the code-behind file of Default.aspx.

6 Add code to the Page_Load event handler to retrieve a Customer object with the CustomerID of 7 and
display the object’s CustomerName property in the TextBoxEditCustomerName control.

7 Add Click event handlers to the ButtonAddCustomer and ButtonSaveCustomer controls.

8 Add code to the ButtonSaveCustomer_Click event handler to retrieve the customer with the
CustomerID of 7 and set its CustomerName property to the value entered in the TextBoxEditCustomer
control.

9 Add code to the ButtonSaveCustomer_Click event handler to commit the changes to the CustomerName

property to the database by calling the SubmitChanges method.

10 Add code to the ButtonAddCustomer_Click event handler to add a new record to the Customer table in
the database.

Set the new record’s CustomerName property to the value of the TextBoxNewCustomerName.Text
property.
(Remember to use the InsertOnSubmit method before the SubmitChanges method).

11 Add try and catch code to all three event handlers and put the Message property of any exceptions
into the LabelError.Text property.

12 View and test the default.aspx page in your browser.

SESSION 10 EXERCISE

Home About

NEW CUSTOMER

Custamer Mame Simon Smart

EDIT CUSTOMER

Customer Mame Hanari Carnes

If you need help
‘ Session10 - start | ‘ Session10 - end | :}l:jfe;?e page to
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Session 10: Exercise Answers

These are the four questions that students find the most difficult to answer:

Q11

Q10

Q8

Q6

1. Enclose Use the following code: Use the following code: Use the following code:
Z}?u; Cﬁ)de m | using using if (!Page.IsPostBack)
¢ tollowing: (Session10DataContext (Session10DataContext {
try Data = new Data = new using
{ Session10DataContext()) Session10DataContext()) (Session10DataContext
[Code] { { Data = new
} Customer NewCustomer Session10DataContext())
_ Customer(); Customer (
2. Add the new ! MyCustomer =
. NewCustomer . Customer MyCustomer
following: Data.Customers.Single
.CustomerName = = Data.Customers
(Customer => .
catch TextBoxNewCustomer .Single
. Customer.CustomerID
(Exception Ex) Name.Text; —7) (Customer => Customer
{ Data.Customers ! .CustomerID ==7);
R MyCustomer K
LabelError InsertOnSubmit TextBoxEditCustomer
.CustomerName =
Text = Ex (NewCustomer); . Name.Text =
. TextBoxEditCustomer
-Message; Data.SubmitChanges(); MyCustomer
Name.Text;
} } \ .CustomerName;
This was This was covered in: Lesson . . !
. This was covered in: }
covered in: 10-8: Insert database records
. Lesson 10-7: Update . )
Lesson 7-6: Use using LINQ. . This was covered in: Lesson
database records using ) )
try and catch to LINQ 10-3: Retrieve a single row of
handle errors. ' data using LINQ.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:
Refer to: Lesson 1-7: Manage a project with the Solution Explorer.

Refer to: Lesson 10-2: Add LINQ data classes to a project.

Refer to: Lesson 10-2: Add LINQ data classes to a project.

Refer to: Lesson 10-2: Add LINQ data classes to a project.

Refer to: Lesson 1-7: Manage a project with the Solution Explorer.

Refer to: Lesson 3-2: Add event handlers to Controls.

Refer to: Lesson 10-7: Update database records using LINQ.

= O N OO b~ ON =

2 Refer to: Lesson 1-8: Run a project in debug mode.
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Session 11: Exercise

1 Open the Spark project from your sample files folder.
2 Open customer.aspx in Design view.
3 Add a LingDataSource control to retrieve records from the Customer table, sorted by CustomerName.

Name your new control: LinqDataSourceCustomer
Add a GridView control and attach it to the LingDataSource control.

Enable sorting and paging for the GridView control.

4

5

6 Add Command fields to the GridView control to edit and delete records.

7 Use AutoFormat to make the GridView control more presentable.

8 Add a DropDownList control to the page. Name your new control: DropDownListCustomer
9

Add C# code to the Page_Load event handler of customer.aspx to retrieve the contents of the Customer
table and place it in the DropDownList control.

10 Set the DropDownlList control’s DataTextField property to CustomerName and the DataValueField
property to CustomerID.

Home New Invoice View Invoices Reports
3 Ana Trujillo Emparedados y helados Edit Delete
1 Bottom-Dollar Markets Edit Delete
10 B's Beverages Edit Delete
9 Cactus Comidas para llevar Edit Delete
- Frankenversand Edit Delete
7 Hanari Carnes Edit Delete
1l Island Trading Edit Delete
8 La maison d'Asie Edit Delete
) Lehmanns Marktstand Edit Delete
6 Magazzini Alimentari Riuniti Edit Delete

If you need help
Spark - start | Spark - end | slide the page to

the left
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Session 11: Exercise Answers

These are the three questions that students find the most difficult to answer:

Q9

Use the following code:

using (SparkDataContext Data =

new SparkDataContext())

{
DropDownlListCustomer
.DataSource = Data.Customers;
DropDownlListCustomer
.DataBind();

}

This was covered in:
Lesson 11-8: Bind data to a control using
C#.

Q6

1. Click Edit Columns... in
the QuickTasks menu of
the GridView control.

2. Expand the
CommandField category in
the Available Fields list.

3. Click Edit, Update,
Cancel from the
CommandField category.

4. Click Add.

5. Click Delete from the
CommandField category.

6. Click Add.
7. Click OK.

This was covered in:
Lesson 11-5: Add editing
features to a GridView.

Q3

1. Add a LingDataSource control to
the page.

2. Set the ID property of the new
control to: LinqDataSourceCustomer

3. Click Configure Data Source... from
the QuickTasks menu of the control.

4. Ensure that Spark.SparkDataContext
is selected and click Next.

5. Ensure that
Customers(Table<Customer>) is
selected in the Table drop-down.

6. Click OrderBy...

7. Ensure CustomerName is selected in
the Sort by drop-down.

8. Click OK.
9. Click Finish.

This was covered in:
Lesson 11-1: Use the LingDataSource
control.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:

0 N AN -

Refer to: Lesson 11-3: Use the GridView control.

Refer to: Lesson 1-15: Use the QuickTasks menu.

Refer to: Lesson 1-7: Manage a project with the Solution Explorer.

Refer to: Lesson 1-7: Manage a project with the Solution Explorer.

Refer to: Lesson 11-4: Add sorting and paging to a GridView.

Refer to: Lesson 1-14: Add controls to a page with the Toolbox.

© 2014 The Smart Method Ltd

321



Session 12: Exercise

©W 00 N O O A ODN -

Open the SmartMethodStore project from your sample files folder.

Open products.aspx from the admin folder.

Add a LingDataSource control to the page which retrieves all entries from the Product table.
Add a GridView control and link it to the LingDataSource.

Add the ability to update and delete products to the new GridView control.

Add a DetailsView control linked to the same LingDataSource control.

Add the ability to insert a new product to the DetailsView control.

Open orders.aspx from the admin folder.

Add LingDataSource and GridView controls to display all records from the Order table where
OrderSent is false and OrderPaid is true.

Add a ButtonField to the GridView control and set its Text property to: Send Order

Add a RowCommand event handler to your GridView control that will set the selected order’s
OrderSent property to true when the Send Order ButtonField is clicked.

THE SMART METHOD STORE

ProductName  amethyst

crystal geode
ProductPrice 150.0000
Images/geode
ProductlmageUrII i
-tnJpg

New

ProductID ProductName ProductPrice ProductimageUrl
1 Large amethyst crystal geode 150.0000 images/geode-tn.Jpg Edit Delet
2 Small amethyst crystal geode 20.0000 images/geode-tn.jpg Edit De
3 Snowflake obsidian keyring 5.0000 images/keyring-tn.Jpg Edit De
4 Large amethyst stone 5.0000 images/amethyst-tnjpg Edit De
5 100g mixed gems 10.0000 images/mixedgems-tn.jpg Edit Delet
6 500g mixed gems 40.0000 images/mixedgems-tn.jpg Edit Delete|
ProductiD 1

Large

If you need help
slide the page to

SmartMethodStore - start I SmartMethodStore - end s Taf
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Session 12: Exercise Answers

These are the four questions that students find the most difficult to answer:

Q11

1. Add a RowCommand event
handler to your GridView
control.

2. Add the following code:

int RowClicked =
Convert.Tolnt32
(e.CommandArgument);

int OrderID =
Convert.ToInt32
(GridViewOrder.DataKeys|
RowClicked].Value);

using

(StoreDataContext Data =

new StoreDataContext())

{
Order OrderToSend =
Data.Orders
.Single(Order =>
Order.OrderID ==
OrderID);
OrderToSend
.OrderSent = true;
Data.SubmitChanges();

}

GridViewOrder.DataBind();

This was covered in:
Lesson 12-4: Create a Products

page.

Q9

1. Add a new LingDataSource
to the page.

2. Click Configure Data Source
from the QuickTasks menu of
the LingDataSource.

3. Click Next.

4. Choose Orders from the
Table drop-down.

5. Click Where...

6. Choose OrderSent from the
Column drop-down.

7. Choose == from the Operator
drop-down.

8. Choose None from the Source
drop-down.

9. Type False into the Value
box.

10. Click Add and repeat the
process for the OrderPaid
property with a value of: True

12. Add a GridView control and
link it to the LingDataSource.

This was covered in:
Lesson 11-1: Use the
LingDataSource control.

Q7

1. Open the Edit
Columns dialog
from the QuickTasks
menu of the
DetailsView control.

2. Add a New,
Insert, Cancel field
from the
CommandField
category.

3. Click OK.

4. Set the
Enablelnsert
property of your
LingDataSource to:
True

This was covered
in: Lesson 11-6: Use
the DetailsView
control.

Q5

1. Open the Edit
Columns dialog
from the
QuickTasks menu
of the GridView
control.

2. Add an Edit,
Update, Cancel
field from the
CommandField
category.

3. Add a Delete
field from the
CommandField
category.

4. Set the
EnableUpdate and
EnableDelete
properties of
your
LingDataSource
to: True

This was covered
in: Lesson 11-5:
Add editing
features to a
GridView.

If you have difficulty with the other questions, here are the lessons that cover the relevant skills:

1 Refer to: Lesson 1-7: Manage a project with the Solution Explorer.
2 Refer to: Lesson 1-7: Manage a project with the Solution Explorer.
3/4  Refer to: Lesson 11-3: Use the GridView control.

6 Refer to: Lesson 11-6: Use the DetailsView control.

8 Refer to: Lesson 1-7: Manage a project with the Solution Explorer.
10 Refer to: Lesson 12-4: Create a Products page.
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